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Trademarks 

T-Mobile and T-Mobile Communication Centre are registered trademarks of Deutsche Telekom Group. 

Windows 98SE, Windows 2000 and Windows XP are trademarks or registered trademarks of Microsoft 
Corporation. 

Products of the companies Option Wireless Technology, SonyEricsson, Novatel, Nokia and T-Mobile are 
trademarks or registered trademarks of their respective owners. 

Bluetooth is a trademark owned by Bluetooth SIG, Inc. 

Other product and brand names may be trademarks or registered trademarks of their respective owners. 

 

Disclaimer and Limitation of Liability 

T-Mobile assumes no responsibility for any damage or loss resulting from the use of this handbook.  

T-Mobile assumes no responsibility for any loss or claims by third party, which may arise through the use 
of this software.  

T-Mobile assumes no responsibility for any damage or loss caused by deletion of data as a result of 
malfunction, dead battery, or repairs. Be sure to make backup copies of important data on other media to 
protect against data loss.  

Important: Please read and accept the End User Software License Agreement with this product before 
using the accompanying software program(s). Using any part of the software indicates that you accept 
the terms of the End User Software License Agreement. 

 

Document Version 2.5.001 

Copyright T-Mobile under license from Alice Systems AB.  Solution includes patents pending for Alice Systems AB. 
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1 Welcome 
Communication Centre Software is a quality product of T-Mobile. This product supports you during your 
daily business, be it at home in your office or while travelling.  

This state-of-the-art software was especially developed for mobile application on notebooks running 
Microsoft WindowsTM .  

The intention with this document is to describe how to install the Communication Centre Software and 
getting started with the software and supported data cards. It also describes first hands-on to configure 
and customize the Communication Centre Software to suit your individual requirements or company 
guidelines. 

For any questions on further configuration please refer to the Communication Centre User Guide. 

1.1 Variants of Communication Centre Software 
The software comes in three different flavours fitting specific customer needs: 

- The Internet type of installation is for the normal user. With its pre-defined settings it 
allows out-of-the-box wireless access to the public internet.  

- The Administrator type additionally is for IT administrators who want to integrate VPN 
solutions for a secure access to the corporate LAN. 

- The Deployment type is for IT administrators that want to create a re-distributable 
installer file with custom options. 

This document describes the Standard variant, which is designed that only minor adjustments like 
installing default devices is needed after installation of the software. 

For any questions on advanced configuration in the Administrator or Deployment variant please refer to 
the Communication Centre User Guide. 

1.2 Three easy steps to mobile connect to the Internet 
The first usage of Communication Centre requires three simple steps: 

1. Install the T-Mobile Communication Centre Software. The installation process includes the 
installation of drivers for T-Mobile Multimedia Net cards. 

2. Assign default devices for bearers to be used (WLAN, UMTS, GPRS, LAN) 

3. Connect to T-Mobile Network and Internet with pre-defined profile “Mobile” 
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1.3 System requirements 
In order to run Communication Centre on a notebook it should meet the following minimum technical 
requirements: 

Processor:   Pentium II processor 

Internal memory:   128 MB RAM 

Disk space:   130 MB 

Operating Systems:  Microsoft Windows XP SP2 

    Microsoft Windows 2000 SP4 

    with Microsoft Internet Explorer version 5.5 or later 

 
Devices (out of the list of supported devices below) 
 
UMTS/ GPRS cards: 

 Mobile DSL Card* or Mobile Broadband Card* 
 Mobile DSL Card Compact* or Mobile Broadband Card Compact* 
 T-Mobile Multimedia Net Card UMTS / GPRS 
 T-Mobile Multimedia Net Card UMTS  

 
UMTS/ GPRS/ WLAN cards: 

 Mobile DSL Card  WLAN* or Mobile Broadband Card WLAN* 
 T-Mobile Multimedia Net Card UMTS / GPRS/ WLAN 

 
GPRS/ WLAN cards: 

 T-Mobile Multimedia Net Card GPRS / WLAN 
 Sony Ericsson GC79 WLAN PC Card 
 Nokia D211 PC Card 

 
GPRS cards: 

 T-Mobile GPRS PC card 
 Sony Ericsson GC75 PC Card? 

 
WLAN cards: 

 T-Sinus 130card2 
 

*: New High Speed Data card from T-Mobile – The name of the card may differ depending on your 
national T-Mobile Mobile Operator.
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2 Getting started with Communication Centre  
Follow the instructions below and you will get up and running with Communication Centre as soon as 
possible. 

2.1 Installation 

 Important Note 

Do not insert the card in the PC until the installation is complete or you are prompted to do so. 
After installation of Communication Centre, the drivers for “T-Mobile Multimedia Net” data cards 
are pre-installed as well. You can plug in your data card immediately. The card will be detected 
by Communication Centre automatically. 
Make sure that any previous installation of these cards is uninstalled, before installing any of 
them again. 
You need administrator privileges on the laptop to run the Communication Centre installer 
package. If this should not be the case, please contact your IT-Administrator. 

 

1. Insert the CD with the Communication Centre in the notebook. A screen is displayed allowing 
you choose to install the Communication Centre 2.5. 

2. Language selection. Select your preferred language for the Communication Centre and click on 
OK. 

3. The next dialog requests to check your national T-Mobile Mobile Operator. Choose your mobile 
operator from the list and then click Next. 

4. License Agreement. Read carefully the license agreement and accept it by clicking Next to 
continue the installation 

5. Installation variant. Select the installation variant, Internet, Administrator or Deployment. Internet 
variant of installation is suitable from the majority of users. The administrator variant is suited to 
those users using compression and/or optimisation software. The deployment variant is best 
suited to IT administrators who want to create a re-distributable installer with custom options. 

6. Installation variant Deployment. In case you have chosen this variant the next step is to select the 
standard "Access Point Name" (APN) for the mobile access to the Internet using T-Mobile 
networks. 

7. After successfully installation of the software, the Summary screen presents the option to reboot 
your machine. To continue and finalise the installation, click on Finish.  

 Important Note 

If the notebook should require a reboot after installation, reboot the PC and then double-click the 
Communication Centre icon on the desktop to start the Communication Centre Software. 
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The installer creates: 

 shortcuts in the Start Programs menu 

 T-Mobile 

• Communication Centre 

o Communication Centre 

o Create Redistributable Installer (Deployment variant only) 

o Email Wizard 

o Getting Started 

o T-Mobile Web 

o Uninstall 

o User Manual 

• HotSpot Locator 

 a shortcut to Communication Centre Software on the desktop 

 a shortcut to Communication Centre Software in the quick launch tray. 

2.2 Uninstalling the Communication Centre  
To uninstall the Communication Centre (and the HotSpot Locator) click the Windows ‘start’ button and 
locate ‘T-Mobile’ under the ‘programs’ tab. Here you will find the Communication Centre Software 
uninstall program. 

It is also possible to uninstall the Communication Centre Software from “Add or Remove Programs” 
respectively “Software” in the Microsoft Windows Control Panel. 
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2.3 Starting the Communication Centre 
Insert your data card into your notebook launch the Communication Centre by clicking on the icon on the 
desktop.  

1 
2 
3 

4 
5 

7 
6 

 

1. signal strength 

2. available networks 

3. network name  

4. launch pad with preconfigured tasks 

5. connection status and data  

6. active profile 

7. connect/disconnect multi function button 

While being launched Communication Centre searches automatically your notebook for installed devices 
and configures the found devices for the supported wireless networks (GPRS, UMTS, WLAN). In case 
multiple suitable devices are found for one wireless network you will be prompted to choose your 
preferred default device.  

After a few seconds your devices are ready to connect to the Internet. Communication Centre highlights 
the available wireless networks with a grey frame, displays the signal strength, the network name and the 
active profile. Clicking the connect/disconnect multi function button will now connect to the Internet. The 
successful connection to the Internet will be highlighted with a red arrow in the centre of the 
connect/disconnect multi function button, the used wireless network will be highlighted with a green 
frame and the actual speed and connection time will be displayed.  

Clicking again on the connect/disconnect multi function button will disconnect from the Internet. 
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3 GPRS/UMTS functions 

3.1 PIN request 
In case you have inserted a valid SIM-/USIM in your data card in your notebook, you will get a PIN request 
any time the notebook is switched on, when Communication Centre is started.  

This PIN has been provided to you in the security envelope together with the SIM card. Fill in the digits in 
the text input field and click OK. You have three attempts. In case all three attempts were in vain the SIM 
card will be locked. In order to unlock your SIM card, you have to provide the PUK, which was also 
provided to you within the security envelope  

 

  Important Note 

If you are unaware of your PIN code, please refer to “Your SIM” documentation provided in your 
new SIM packet.  Your PIN code is the 4 digit number on the bottom right hand of the document.  
If you are still unable to find the PIN code please contact customer services for assistance. 

3.2 Changing the PIN 
To change the PIN go to the menu Options | GPRS/UMTS Devices | PIN Management. Activate Use PIN 
and fill in the digits for the current PIN, new PIN and confirm PIN and click OK to activate the new PIN. 
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3.3 Deactivating the PIN  
To deactivate the PIN go to the menu Options | GPRS/UMTS Devices | PIN Management. Activate 
Disable PIN Security and click OK. 

 

3.4 Setting the frequency band 
Go to the menu Options | GPRS/UMTS Devices | Frequency Band to set the used GPRS/UMTS 
frequency band. The actual used frequency band is marked with a grey bar in the list of the supported 
GPRS/UMTS frequency bands. Select the new frequency band with a click and activate the new 
GPRS/UMTS frequency band by clicking OK. 
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3.5 Selecting the GPRS/UMTS network operator 
Go to the menu Options | GPRS/UMTS Devices | Network Selection to select the GPRS/UMTS operator 
manually. Communication Centre will start to fetch the network operator information this may take several 
seconds. All possible GPRS/UMTS operators will be displayed. Select the GPRS/UMTS operator you 
want to use with a mouse click and click Change Operator. 
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4 Device Manager 

4.1 Device installation 

 Important Note 

Do not insert the data card in the notebook until the installation is complete or you are prompted 
to do so. 

The Communication Centre supports a variety of UMTS/ GPRS/ WLAN data cards. The supported devices 
are presented in the drop-down menu of the “Device Installation” wizard. This list can be found in 
Communication Centre Options menu, under UMTS/GPRS Devices and Install Device…: 

1. Go to Options | GPRS/UMTS Devices | Install Device to start the device installation.  

2. The Device Installer Wizard will be displayed. This wizard provides two options for device 
installation. You may either scan your notebook for pre-installed devices or install a new device. 
Select the option you want and click Next. 

3. For the option install a new device the next screen will present the choices between manually 
select device from a list and auto detect attached devices. 

4. For the choice manually select a device from a list the next screen will present a drop down list 
containing all supported data cards. Select you data card and click Next to continue.  

5. The device drivers will be installed. 

6. Upon successful device installation the Device Installation Wizard will be closed. You may now 
insert the data card in your notebook, it will be configured automatically and is ready for 
operation. 
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4.2 Selecting default devices 
In case the automatically selected default devices are not appropriate for your tasks you may use the 
Device Manager to manually change the default devices. The Device Manager allows you to select a 
default device for each supported network. 

Got to Options | Preferences and click the Device Manager tab to manually select the default devices. 
The Device Manager displays all selected default devices. Click Choose to select a different default 
device for a specific network.  
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5 Network connections 

5.1 Supported networks 
In combination with appropriate data cards (T-Mobile Multimedia Net Cards, Intel Centrino WLAN) 
Communication Centre Software allows the connection to various bearers like WLAN, UMTS, GPRS and 
LAN.  

On start up, the Communication Centre attaches to different bearers according to how it is configured. To 
get the most out of T Mobile Hotspots and UMTS/ GPRS connectivity, the Communication Centre 
Software is preconfigured to attach to WLAN and UMTS. If the device does not support UMTS or if there 
is no coverage for UMTS, the GPRS network will be used if possible. 

5.2 Connection profiles 
In order to simplify customer’s life, Communication Centre comes with a pre-defined profile “Mobile”, 
which allows out-of-the-box wireless access to the public Internet via T-Mobile HotSpot, UMTS and GPRS. 
Dependant on the network coverage, the fastest network will be selected automatically when pressing the 
Connect/Disconnect multi function button. You may also manually select a specific connection and 
bearer with the Connect/Disconnect multi function button, just click the little black arrow on the 
Connect/Disconnect multi function button and a list with available connections will be enrolled. You may 
now select the connection with a mouse click. 

5.3 Changing the active connection profile 
The pre-defined default connection profile is called “Mobile”. Go to File | Profiles to change the active 
profile. The actual active profile is displayed in upper right corner of the light blue screen within 
Communication Centre.  

Note: The other pre-defined profiles called “Office” and “Home” are empty profiles. In order to use those 
profiles you must first configure them. Go to Options | Configuration and then select Connection Profiles 
in order to configure a profile. For more information about configuration refer to the User Guide.  

5.4 Connect/Disconnect multi function button 
When the Communication Centre is started, we advice you to wait until the operator name and signal 
strength are shown in the Status Display. Once you can see T-Mobile operator name, the PC is attached 
to the network. The left side of the Status Display shows which bearers are currently available 
(highlighted). Now use the Connect/Disconnect multi function button to establish a connection to the 
network. 

 

Clicking this button makes the Communication Centre connect via the bearer according to the 
connection order (priority list) in the active profile.  
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When a connection is active, the Connect/Disconnect multi function button turns into a Disconnect 
button. You may terminate a connection by clicking the red highlighted Disconnect button. 

 

Further more, status information such as online time, average data throughput (speed) is also displayed 
while connection is active. 

It is also possible to connect with any configured connection by using the context menu of the Connect 
button. In this case the connection order in the active profile is not used. Instead the connection is 
established with the bearer selected by clicking on the name as shown. 

 

Click on the small triangle of the Connect button to choose among available connections. By clicking on 
just one entry out of the list, Communication Centre Software tries to establish a connection with that 
network. 
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5.5 Network display and status information 
The light blue screen in the centre of Communication Centre displays all important information about the 
status of your network connections. 

 

 1 

 2 

 3 

 4 

 5 

 6 

 7 

 

The status information displayed in the light blue screen contains following information: 

1. SMS-envelope, displays received SMS  

2. network signal strength  

3. connected network is marked by a green frame 

4. available networks are marked by a grey bar 

5. network name 

6. time and speed of the current connection 

7. name of the active connection profile 
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5.6 Application launch pad 
The launch pad resides in the bottom of the Communication Centre and contains the application buttons 
for each of the tasks. A task can establish a connection as well as launch a set of user applications after a 
connection is made. 

The launch pad can be toggled between two different views. By clicking the View menu you can choose 
whether the launch pad shall be visible at all times, along with showing the tool text next to the icon. 

 

For more information regarding tasks please refer to the User Guide. 
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5.7 HotSpot support 
The HotSpot service is a wireless internet service area found in numerous public locations like in 
coffeehouses, hotel lounges, airport lounges etc. Using the Communication Centre it will automatically 
display the availability of HotSpots operated by T-Mobile and T-Com. The Communication Centre 
supports automatic login handling to a HotSpot with subscription data based on your mobile account (i.e. 
4417100007@t-mobile.net). The credentials of such subscription can be ordered with Communication 
Centre manually as well as by using the automatic mode.  

Quick Guide to login to a HotSpot: 

1. Press the Connect button, whenever a HotSpot is available (this is shown as operator “HotSpot” 
in the Status Display). The Communication Centre will check whether required subscription 
account information is stored. If the Communication Centre Software doesn't have necessary 
subscription account information, it will offer to acquire them automatically from the     T-
Mobile HotSpot server. 

2. In automatic mode, Communication Centre displays a dialog to accept the terms and conditions 
of HotSpot. Please read and click on Accept to continue with the HotSpot login otherwise you 
are prompted to enter them manually in the form. 

3. Having accepted the terms and conditions, Communication Centre sends an SMS and receives 
an SMS with the user credentials and account information. Therefore a device with a T-Mobile 
SIM card needs to be attached to the PC and configured as default device to be used for GPRS 
or UMTS connectivity. 

4. Should Communication Centre be used in automatic mode, the credentials will be parsed out of 
the SMS response and then used to enter the HotSpot service area. 

If you already have a subscription or want to use the mobile phone to acquire the subscription data, just 
enter the username and password in the dialog box in the Communication Centre Software. This dialog 
box is displayed in automatic mode or can be found by clicking in Tools | HotSpot | HotSpot Account to 
manage the username and password. 

  Important Note 

The HotSpot service is a public WLAN offer from T-Mobile and T-Com as a Wireless Internet 
Service Provider (WISP). The use of HotSpot will be charged separately on your mobile phone 
bill or via credit card. Without accepting the terms and conditions you can’t access the internet 
via HotSpot. 

Once the Communication Centre has acquired the subscription data, it will use them automatically 
whenever requested to login to a HotSpot. It also supports the logout from the HotSpot. When you have 
finished your internet session, use the Disconnect button in order to logout from the HotSpot. As soon as 
the HotSpot server has disconnected you from the Internet, the Status Display will show "offline". Note, 
that using the logout button from the HotSpot website is also possible and the Communication Centre will 
display “offline” after a few seconds.  

For further information about the support for subscription based HotSpot access, please refer to the 
website of your national T-Mobile operator or the login page of the HotSpot service area. 
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5.8 Configure WLAN 
The Communication Centre is fully WLAN compatible and supports access to WLAN in many locations 
such as home, in the office or even in public locations with HotSpot coverage. 

With the help of Communication Centre’s WLAN sniffer you will be able to sniff for available wireless 
networks. The WLAN Sniffer is found by clicking the Tools menu and then on WLAN Sniffer. This tool 
displays the network name of available wireless LAN networks. You may configure a connection on it and 
assign this connection to be used in the profiles of your choice. 

 

In the configuration of Communication Centre  you can define various technical details like WEP 
encryption, WPA, proxy settings and login modules to be used. Detailed information on these 
configurations can be found in the User Guide. 
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6 Preferences 
A limited number of configuration options are available in the Preferences menu. This can be found under 
the Options menu. In the General tab you will be able to define the start up screen, auto start and 
confirmation settings. In the Device Manager tab the default devices that shall be used with 
Communication Centre Software need to be defined. 

6.1 General preferences 

 Start screen: The application can be set to have a specified window size on start up - Standard 
and Toolbar view. 

 Always on Top: This option controls whether Communication Centre should stay on top of other 
application windows or not. 

 Auto start: If set to “Yes” then Communication Centre will be launched on start up of the PC, 
otherwise you can start the software manually. 

 Confirm Disconnect: This option lets you decide how to handle disconnects. If set to “Yes” then 
Communication Centre will prompt you to confirm the disconnect action before actually 
disconnecting from the network. 

 Speed manager plus: This option lets you decide whether compression services are used for 
optimised Web surfing or email download. 
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7 Configuration 
The Communication Centre is designed that only minor adjustments like installing default devices is 
needed after installation of the software. The Communication Centre Software allows you to configure the 
software with additional connections, profiles, tasks and several supported applications like VPN Clients 
or Optimization Clients. 

The Configuration should only be used carefully since modifications on connection settings might cause 
general connectivity problems. Please refer to the User Guide for detailed information on configurations. 
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